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1 Software installation procedure 
When you insert the installation CD into a CD drive, the ComGuard 3.1 installation menu will be run 
automatically.  Follow the necessary steps in the displayed procedure. 

If the PC contains MS SQL server 
If ComGuard software is being installed on a PC, where MS SQL is already running, the following step 
(MSDE installation) should be skipped. 

MSDE installation 
Installation of MSDE (Microsoft Data Engine) provides MS SQL support for a computer. Installation 
does not require any user settings as the installation is automatic. Restart the PC after the installation of 
MSDE. 

ComGuard SW installation  
This step installs the ComGuard software. 
During the installation you will be asked for editing certain parameters: 
- checkbox for configuration of installed parts  - ComGuard and Comtransporter; the Comguard should 

be checked everytime, the ComTransporter only if the MS-33 GSM module is installed. 
- The setting of the main database connection (see the fig. 1); the displayed setting in the dialog 

window are recommended to be kept.  
- The setting of the destination path of the installation, the displayed setting in the dialog window are 

recommended to be kept.  
 

 
 

Fig. 1 Database connection dialog 
 
 

The MS-41 PCI card installation 
Please the manual of the MS-41 card for installation.  The application for the MS-41 card management is 
installed by the step „BS Quatro Guard“  in the installation procedure. 



2 A brief overview of ComGuard’s structure  
ComGuard software is an inseparable part of the MS-350 monitoring station. ComGuard manages 
received event messages, performs translation according to the translation tables and stores them in the 
database.  
All the information about accounts and received event messages is arranged in four basic windows: 
� Messages 
� Important messages  
� Accounts 
� Accounts status 

 

 
 

3 Setting into operation 

3.1 Software initialisation 
When ComGuard is run for the first time after installation, the user is asked to set the appropriate COM 
port to which the MS-350 unit is connected. If the MS-350 unit is not currently connected , choose any 
COM port. The chosen port must not be occupied by another application. 
Entering a user name and password finishes the initialisation. The default operator after initial software 
installation is „Supervisor“ with the password „123456“. Changing the password during the first run is 
recommended. The Supervisor operator cannot be erased from the list of operators, only changing the 
password is possible. 
The order of operation during the first run should be as follows: 

1. Change of Supervisor password – see chapter 4.2 
2. Setting of MS-31 card regular checking – see chapter 8.  
3. Setting of operators – chapter 4.2 
4. Checking of preset formats and editing of formats – chapter 4.3 
5. Setting and creating accounts – chap. 4.4 

3.2 New operator, edit operator 
Windows is used to administrate operators and theirs rights. 
The complete operator list is on the left side of the window. Operator information is displayed on right 
side of the window. A left mouse button click chooses the operator you want to check through. Operators 
having supervisor rights are allowed to insert a new operator, to delete, and to copy or edit selected 
operators. Besides editing and reading operator information, the window enables a supervisor to change 
an operator’s rights by clicking on the appropriate button on the right side of the window. This window 



offers insertion of the operator contract shortcut to the Supervisor. Before opening the file, the path to 
the text editor must be defined (see chap. 6.5.5.). 
 

 
 

Fig. 1 Operators list 
 

The default operator after installation is Supervisor with the password „123456“.  
 
Buttons 
 
The meaning of the particular operator items and buttons is shown by their labels: 

• New - creates access to ComGuard for a new operator.  
• Edit - is used to edit operator details. Clicking the Edit button once activates the right part of the 

window to make changes. Only the operator with supervisory rights is allowed to change each of 
the details and rights. E.g. an operator with password change rights can change his own password, 
but others’ details.  

• Delete - deletes a selected operator from the database.  
• Copy - creates a copy of a selected operator. A copied operator does not have the same password 

and it remains empty until it is changed. The name of the operator is set to New operator. Others 
items are kept like the original.  

• Find - searches for an operator by name.  
• Working hours - it displays a window showing the login and logout times of operators.  
• No access - this button temporarily denies access to a selected operator .  

To confirm the operator item changes click on the OK button. 

 

3.3 Preset formats 
You can find a list of preset formats in the menu by selecting Tools then Formats. The default formats 
are: 
� Ademco Contact ID 
� 4/2 
� SurGard 
� Ademco Express 
� Contact ID Jablotron  
� Contact ID CA-12XX 



Even though the protocols Ademco Contact ID, Contact ID Jablotron and Contact ID CA-12XX have the 
same structure, there is a significant little difference. The sources for Ademco Contact ID are empty and 
only the translation table for the general part contains texts. The formats Contact ID Jablotron and 
Contact ID CA-12XX are fully configured for the receiving and translation of messages from Jablotron 
control panels. The format Contact ID CA-12XX is pre-configured for messages from Jablotron car 
alarms of the CA-12XX series. 
Formats 4/2, SurGard and Ademco Express are also preset for Jablotron control panels.– All the text in 
the translation table can be adapted to any compatible control panel. A translation table can be imported 
from an external *.csv file. Several importable files are contained on the supplied installation CD. 
A detailed description of format setting is in chapter 8.1. 

3.4 New account  
The number of preset accounts after software installation conforms to the preset formats. The names of 
accounts comply with the format, which is chosen for the particular account. 
The overview and setting of accounts are accessible in the Accounts window – one of the four basic 
windows. 
A new account in the database can be created by clicking the New or Copy button. When the New button 
is clicked, the new account contains no data. The software offers a new account ID to the operator.  
If a new account is created by the Copy button, the new account inherits all the data and settings of the 
original account except the account ID and account name. The name is created from the original name 
with a “#“ sign on the end.  
Every account has its own unique account ID, duplicate account IDs are not allowed in the database. If an 
operator tries to use an existing account ID for  another account, ComGuard notices this and prevents it. 
However, account names can be shared by more then one account. 
 
A new account only needs three parameters to be set for receiving messages: Account ID, Account name 
and the communication format. 
A detailed description of these settings can be found in chapter 7.1.3. 
 

4 Message administration 
All the messages received by telephone card MS-31 or by GSM module MS-33 are arranged in the 
Messages window according to the time when the messages were received. Messages of type “Alarm” or 
“Fault” are displayed in the Important Messages window. The order in these two windows can not be 
changed. 

4.1 Message filtering 
Received messages can be filtered according to the following criteria: 
� the date of reception, 
� the message type, 
� the account name, 
� the account ID 
� the text or the text part of the message translation. 

To activate filtering, press the right mouse button under the Message window, then choose Message 
filtering. The dialog window for filter settings will then be displayed (see fig. 2).  



 
 

Fig. 2. Filter window  

4.2 Additional notes 
 

 
 

Fig. 3 Additional notes 
The Message window contains two columns where extra information for each received message can be 
added. Add notes - This item invokes a dialog box with predefined Standard notes and customizable 



Optional notes. To move a chosen note to the right window, click the  arrow down. Please note: 
none of the notes in the right window can be erased. The time of note creation is added automatically. 
After closing the dialog box the appropriate note will appear in the Standard notes or Optional notes 
columns. The existence of  notes is shown by the word Yes in the Note column . 
 

4.2.1 Predefined notes 
An operator can add some extra information to a chosen message. There are two kinds of additional 
notes: predefined (standard) and optional notes. In the case of predefined notes, an operator can choose 
suitable notes from a list. The list of predefined notes is intended to make working with notes easier and 
faster. Typical examples of standard situations that could be rated by predefined notes are false alarms, or 
the incorrect operation of equipment. 
The list is created by selecting the Tools menu, then the Predefined item.  
The following picture shows an example of creating predefined notes, that are offered afterwards as a list 
of standard notes in the Messages window. 
 

 
 

Fig. 4 Predefined notes 
 

The upper editing field is used for editing a new standard note. To move the new notes to the list click the 
Add button.   
Button functions : 
Close – closes the Predefined notes window 
Help – displays the help window 
Add – adds a new note to the list from the upper editing field. 
Delete – deletes highlighted notes from the list 
Save – saves the contents of the window to the database. 
 

4.3 Unrecognized messages 
When the Message window displays the event message “Telephone line error or wrong format”, 
ComGaurd has just received a message which can not be translated because of a non-existent Account ID 
in the database or a non-existent report code in the translation table. If a received message belongs to an 
account in suppressed mode, the message will not be translated either, so the text “Telephone line error or 
wrong format” will be displayed instead of the proper translation. 
All the messages received that have not been translated can be found in the Unrecognized messages 
window. This window is accessible via the View menu. 
The window contains four columns:  

• Date and time of message reception, 
• Account ID, if recognized 
• The code of the received message 
• The account source (see chap.7.1.1)  



 
 

 
 

Fig.5 The Unrecognised messages window 
If the source is SMS, GPRS or TCP, the Code column contains a string of 15 characters that correspond 
to a Contact ID format code without a checksum. 
When a message is received by the MS-31 telephone card, the code is displayed with the structure of 
COM port serial communication. The meaning of the message is as follows: 
Received message e.g.: E1 06 05 01 0A 04 03 04 3A 
E1 – the message was received by the card with an address of 1, 
06 – the message contains six figures, 
05 01 0A 04 – Account ID - 51A4 in this case,     
04 03 – report code of the received message –43 in this case, 
3A – the check sum of this particular serial data communication 
  

4.4 Translation table editing 
The installation of ComGuard2 creates the following list of formats (plus other items): 

− Ademco Contact ID 
− 4/2 
− Ademco Express 
− SurGard 
− Contact ID Jablotron 
− Contact ID CA-12XX 
 

As regards the translation tables, all the preset formats are adjusted for Jablotron control panels, except 
for Ademco Contact ID format.  
When any change of text or format is requested, select the Tools menu, then select Format. For detailed 
information about format editing see chapter 8.1. 
 

5 The automatic functions of ComGuard software 

5.1 Actions performed according to message type 
ComGuard software performs certain actions according to the type of message received . The message 
type is set for every line in each translation table (see chap. 8.1) and the colour of the message in the 
Message window is chosen according to the message type . There are the following message types to 
choose from: 
 

 Other event – black    
 Disarmed – black 
 Armed – black 



    Alarm – red 
 OK – green 
 Battery fault – blue 
 Battery OK – blue 
      Power fault – blue 
 Power OK – blue 
 Unspecified failure – violet 

 
When a received message is of the type Armed or Disarmed the appropriate account is set to armed or 
disarmed status. The status of the account is displayed in the Accounts window (the Status sheet) and in 
the Accounts status window. Account status is evaluated according to whether the message type is 
arming or disarming ; see the chap. 6.2. 
The alarm message type triggers an Alarm window when it is set to be displayed. During the time the 
alarm window is visible, the ComGuard software does not receive any other messages, until the alarm is 
confirmed by an operator. 
The alarm, fault and unspecified failure message types are also displayed in the Important messages  
window. 
ComGuard software has three modes for alarm message display, which can be set by selecting the Tools 
menu, then Setting, then the Messages sheet: 

1. ComGuard displays an alarm window - an operator must confirm the alarm window. 
− the Show alarm window button is clicked, Suppress confirmation is not clicked. 

2. ComGuard displays an alarm window- operator confirmation is not required 
− both buttons are clicked – the Show alarm window button and the Suppress confirmation 

button. 
3. ComGuard does not display an alarm window, alarm messages are displayed directly in the 

Important messages window.  
− the Show alarm window button is not clicked. The status of Suppress confirmation makes 

no difference. 

5.2 Account status checking (arm/disarm mode remote monitoring) 
ComGuard software provides a function, which automatically monitors whether the alarm system 
associated with the account is armed or disarmed and compares this information with the expected typical 
state listed in the timetable.. 
The schedule for the arming timetable can be set in the Account window. 
Choose the account in which you want to set the fields in the arming timetable by clicking the left mouse 
button on to the particular account in the account list , then click the Edit button and search through the 
Arming time table sheet. 
The Could be disarmed table is used for information only, as arming has a much more important 
security impact. The account will be expected to be in disarmed mode during the set time period. The 
setting of this part of table has no effect on ComGuard functions.  
The Should be armed table: 
• This is the expected  and typical arming time. 
• In the case of an infringement of the arming time schedule, events are notified to the operator by a 

special dialog box, and in addition, events are recorded in the Messages window and in the 
Important message window. 

• If it is temporarily required that the building be exited later than normal, the operator can set up a 
delay for the activation of the special dialog box. To set it up, find the Tools menu, then the Setting 
item marked Arming time table tolerance. It has a resolution of minutes and the programmed 
interval is added to the start of the normal arming time. Please note: this arming time offset effects all 
accounts. 



5.3 Monitoring the time since the last message  
ComGuard can monitor the time period since the last message for a particular account. 
Select Tools menu, Setting item, Messages sheet. Look at the No message warning after... parameter.  
The default interval is set to 24 hours. If no message is received from a particular account during this time 
interval, ComGuard takes the following action: 
 
The event is displayed in the Messages window and also the Important message window and the event  
has an alarm status. 
 
The default time setting is 00:00 as set in the editing field when the 24 hours extension button has not 
been clicked. It means that the monitoring interval is 24 hours. The setting in this window is valid for all 
accounts in the database. The monitoring interval can be set from 5 minutes to 47 hours 59 minutes. E.g. 
to set the monitoring interval to 26 hours, click the 24 hours extension button and enter 02:00 into the 
editing field. If the 24 hours extension button had not been clicked in this case, the checking interval 
would only be 2 hours. 
The setting of the interval can be set individually for a particular account: 

− Open the Account window, 
− click on the account you want to edit by pressing the left button on the mouse. 
− enter edit mode, 
− choose the Account status sheet, 
− release the Use global setting button, 
− set the checking interval according to the above mentioned procedure. 

  
5 minutes is the shortest recommended monitoring interval because ComGuard checks all the accounts 
once every 3 minutes. So there is no point in setting a shorter interval.  
 
If a particular account should not be monitored for periodic messages, the function can be disabled: 

− Open the Account window, 
− click on the account you want to edit by pressing the left button on the mouse. 
− enter edit mode, 
− choose the Account status sheet, 
− click the Suppress button. 

 
 

6 Windows overview  

6.1 Main windows 

6.1.1 Messages 
The window displays messages coming from particular ARCs (Alarm receiving centres). The messages 
are sorted by time of arrival to the ARC and in the case of an alarm, the message order is decided by the 
time of confirmation. An operator is not allowed to sort the messages, the last one is always at the end of 
the list.  
The window is divided into the several columns with the following subjects:  

• The first column is the reception time of the message (Received at). With the reception time, a 
specific icon appears according to the event. Various colours differentiate message types that 
could be set in the definition window of the Formats.  

• Event. Message texts are generated according to the translation of the format used. The type of 
event is differentiated by text colour.    

• Account code or abbreviation.  



• Account name.  
• The alarm message also contains the time of confirmation - Confirmed by operator.  
• Note is a flag for a further specification, which is located in the Standard notes or Additional 

notes column .  
• Message Code. It is used for checking a received message translation. 
• Source - the direction, from which the received message came:  

•  
− the letter Z followed by number 0-4 - the message was sent by telephone line to the MS-31 

receiver card with address 0-4. 
− abbreviation CG - message generated by ComGuard itself,  
−  SMS - The message was sent by a JA-60GSM via SMS. The MS-33 GSM module received 

the message, 
−  GPRS - The message was sent by a JA-60GSM via GPRS. The MS-33 GSM module received 

the message, 
−  TCP - The message was sent from a JA-60GSM via GPRS and was received as a UDP packet 

from the Internet. 
• The last two columns contain Standard and Additional notes. Standard notes must be predefined 

using the Tools menu, then the Predefined notes item. When the source of the message is SMS, 
GPRS or TCP, the Additional notes contain the real time of the received event. 

 
Fig.6. Messages window 

If the right mouse button is clicked on to any message, it rolls out the two items 
menu:  

• Add notes - This item invokes a dialogue box with predefined Standard notes and variables 

Optional notes. To move a chosen note to the right window push the  arrow down. 
Attention! No notes can be erased in the right window. The time of note creation is added 
automatically. After closing the dialogue box the appropriate note will appear in the Standard 
notes or Optional notes column. The existence of any note is signalled in the Note column by the 
word Yes. 

Message filtering - The item invokes the dialogue box offering 4 types of filter. Filtered messages are 
displayed in an extra window. You need not only use one characteristic to filter messages; the 
operator can use combinations of several characteristics. Pushing the appropriate button down on the 
left part of the dialogue box activates the filters. 

- Time period filter - choose the date From - Till. 
- Message type filter - If you want to choose several message types at the same time, hold 

the CTRL key down and choose the desired message types by clicking the left mouse 
button on to them. 



- Installation name filter - the choice is made in the same way as above. 
- Account ID filter – the operator can enter an account ID to perform filtering. 
- Text filter - the specified text is searched in the Event column. The Filter can be modified 

by capital differentiation or whole words separated by spaces as well as by other 
separators. 

- Help – Invokes the contextual help in the special window. 
• After filter activation, an extra Filtered messages window appears containing the required 

messages. 

 
 

Fig.7. The Filter window 

6.1.2 Important Messages 
 
The Important messages window is used for the online filtering of alarm messages and various kinds of 
failure messages –battery faults, AC faults, and unspecified failures. The Important messages window 
simplifies managing the most important messages; the operator can see these messages for a longer time 
in comparison to the Messages window, where all the received messages are displayed –including 
arming, disarming, periodic testing, etc.  These messages are overwritten by newly received messages. 
All the messages are arranged according to the time of reception, an operator cannot change the order. 
 

6.1.3 Accounts 
• The Accounts window  contains a list of available accounts and theirs IDs. 

Only clicking the left mouse button on the account name selects the account. If an account name in the 
list is only highlighted but not clicked on, it will not be selected. Choose the account carefully to avoid 



mistakes, e.g. in the case of account erasure. After choosing an account, all the sheets on the right side of 
the window will be filled by the properties of the chosen account. 
The account list can be sorted by name or ID. The sorting function can be done using the menu bar (sort 
by…) or by clicking on the header of the appropriate item (Name or ID). The sorting key is shown by a 
triangle in the header of the item. 
If the right mouse button is clicked, the following menu appears: 

• New - creates a new account on the list with the name "New installation". It is only possible to 
allocate a particular name to a particular account, i.e. account names cannot be duplicated. A new 
account is created with an ID of "0", but without a format. 

• Edit - is used to change account settings and to insert detectors in to a map. Clicking the Cancel 
button exits edit mode without saving changes. Another way to exit the mode is by clicking the 
OK button which saves the desired changes to the database. The Contact addresses and 
Messages sheets and the Source table function are exceptions. In these cases the changes are 
saved to the database by directly clicking an appropriate OK button. If a copy of an account is 
created, all changes will be saved automatically without a confirmation question. 

• Copy - creates a copy of an account. The name of a copied account is generated from an original 
name by adding a hash (#) to the end of it. The program allows the creation of up to 10 copies. 
This means an account name may contain 10 hashes.  If an original account contains e.g. two 
hashes, copies may contain 12 hashes. 

• Delete - account deletion. Note: only the current account can be deleted, i.e. the account chosen 
by the left mouse button. 

 

Fig.8. The Account window   
 
• Sort by name – sorts the account list by name. 
• Sort by Account ID – sorts the account list by ID. 
• Reverse order -  
• Sorting of accounts is done using menu items or by clicking the list heading. The course and sort 

key is assigned by a triangle. An up-turned triangle peak assigns ascending order and a down-
turned triangle peak assigns descending order. The sort keys are an account name and an account 
ID.  

• Search - The search keys are an account name and an account ID. The found account will appear 
in the list as current. Is it possible to search whatever string in the contact information attached to 
a particular account – search by “Contact” 

 



 
 

Fig.9. The Search accounts window 
 

 

 

Fig.10. The menu for the Accounts window 

Buttons 
The meaning of the buttons is the same as the menu items (see fig.6) 

• New - new account creation. 
• Edit - edit account items. 
• Delete - account deletion. 
• Copy - account copying. 
 

Sheets 

General 
• Name – the name of an account is displayed in the Message window and in the Account mode 

window. 
• Description – text box*. 
• Account address (street, city, ZIP/postal code). 
• Contact phone number (phone 1, 2 & 3, fax, mobile). 
• Notes for the chosen account - text box*. 
• Contract – shortcut to a document “Guarded installation Contract” (generally an MS Word 

document). 
• For identification purposes - ID or an abbreviation (it depends on the account item you want to use as 

identification in the messages window). 



• Format - this item is used to choose an actual format for communication with exchanges. 
• Ignore Account button - If the button is pressed down, the account does not receive any messages, it 

does not communicate, but all of the properties are kept. ComGuard does not recognise an account 
that is in “Ignore Account” mode, that is why the messages from the account appear in the 
Unrecognised message window.  

 

Instructions for operators 
• The editable sheet with information for an operator – text box*. 

How to act in place 
• The table contains information in the case of an alarm occurrence in an account. The text, which is 

written in the edit window, appears in the special alarm window. The special alarm window is 
always displayed on top, even if the program is minimised to an icon.  

• The table contains a contact address in the case of an alarm occurrence. 
• At the bottom of the sheet is a line for adding a shortcut to an executable file (*.exe), which is 

activated in the case of alarm message. If the path of the shortcut is wrong, the fault is notified in 
the “Message” window – Calling of external process failed – Error code 2.  

 

Account maintenance info 
• The table contains technical information about account maintenance. The text box* is reserved for 

records of an Intruder alarm system account and the service organization.  

Account map 
• Contains three shortcuts to graphics files (format *.BMP) that represent account maps. 
• In common viewing mode it is possible to view a map with detector locations. This mode is 

invoked by clicking the View button. 
• The Edit button opens edit mode, where an operator is allowed to insert detectors into the map 

using the items library. The selection of a detector or an object, and inserting it in to a map is 
performed by left mouse button clicking. If the right mouse button is pressed, it opens the three 
item map menu: 

−  Add item - inserts the selected object in to the map. 
− Delete item - deletes an object on the map. 
− Edit item – allows the operator to enter a short description of the item (up to 8 characters). 

To edit an account map a more advanced operator can edit a map using graphics software 
and only insert a shortcut to this externally created account map. 

• When a map file is open in edit mode or view mode, the operator can print this map by clicking  
the appropriate button on the toolbar. If the map has been edited in edit mode, the changes will be 
saved for printing after closing edit mode.  

• The changes that are done in Comguard (the addition of schematic symbols) have no effect on the 
original map. 

 

Account status 
• Displays the current account status (Disarmed, Armed, No data and Unknown). 
 



 
 

Fig.11. The window Account, Account status sheet 
 

The time is displayed for the statuses Disarmed, Armed and No data. The time corresponds to the 
moment of the message arriving in the system. It applies to both Disarmed and Armed status. The time 
in the case of No data status represents the moment of the last message arriving from the account. 
In the case of battery failure or mains power supply failure the battery and mains power indicators will 
indicate red. To deactivate this state, switch the account to edit mode and click the Override button. The 
indicators return to the normal state after event confirmation. The normal state is indicated by the grey 
colour of these indicators.   
The Arm and Disarm buttons are operated in the same way as the Override buttons. 
Until a new message arrives, the system is not aware of the status of accounts when the program starts, so 
the Unknown indicator is lit. This state of the indicator continues while no status message has arrived.   
Every account can have its own setting of the supervision time– checking the time of receipt of the last 
event. After the set time interval without any event having been received, ComGuard releases the 
notification “Lost communication with installation”. This event is written to the “Message” window. 
The supervision time for all the accounts is set in the Setting window (see chapter 6.5.5.). To set the 
supervision time for a selected account, release the “Use global setting” button, then the supervision time 
set here is valid. For a particular account you can also suppress the 24 hour preset interval by pressing the 
“Suppress24 hours extension” button.  
 

Messages 
• To display account events click the Refresh button. 
• The displayed messages are filtered by account ID, i.e. it might display messages belonging to a non-

existent account having the same ID as a present account. 

Arming time table 

Can be disarmed 
• Expected working hours at the premises of the account - serves as information only. 

Should be armed 
• Assumed arming time. 
• In the case of an infringement of the arming time, events are notified to the operator by a special 

dialog box and in addition, events are recorded in the Messages window. 



If there is a requirement for exiting the building later, the operator can set up a delay for the activation of 
the special dialog box. To set it up find the Tools menu, Setting item, then Arming time table tolerance. 
It has a resolution of minutes and the set up interval is added to the start of the arming time. This setting 
of the Arming time is observed by all accounts! 

 

Fig.12. The Accounts window, Arming time table sheet 

Contact address 
• Contact details (address, phone number) of the person responsible for a monitored account. 
• In the case of account printing, only the first address will be printed alphabetically. To sort the person 

list in order of importance, write a number as the first character of their names. 
Rem.: text box* - rules and tools for editing this field are the same as in the “Windows text fields”. E.g.: 

to reach the next line press the CTRL-Enter keys.   

 
Fig.13. The Accounts window, Contact address sheet 

 

6.1.4 Account status 
This window displays the status of all accounts (Disarmed, Armed, No data, Unknown, Battery fault and 
Power fault). The current status is shown by a cross (X).  
To sort accounts, click the heading in the wanted column, no matter which one is chosen as a sorting key. 
The order and a sort key are assigned by a triangle. An up-turned triangle peak assigns ascending order 



and a down-turned triangle peak assigns descending order. This window cannot be closed. It can be only 
minimized to an icon. 
 
Until a new message arrives, the system is not aware of the status of accounts when the program starts, so 
all accounts have an Unknown status. This state of the indicator continues while no status message has 
arrived.   
 

 
 

Fig.14. Account status window 
 

6.2 Other windows 

6.2.1 Unrecognised messages 
This window displays messages, that have not been identified or messages without a corresponding 
translation. This window is also very important for the proper setting of communication of the ARC and 
accounts. 
 
It is divided in to four columns:  

• Received at - the time of message reception. 
• Account code - account ID, if the number has been identified. 
• Code - the received messages in hexadecimal code. 
• Source – the source of the message. 

If Z10 is displayed in the Source column, then the corresponding ARC with implicit hexadecimal address 
0A sent the message. 
 

 

Fig.15. The Unrecognised messages window 
 
The messages in the window cannot be sorted and the context menu is not available. The Unrecognised 
messages window is made for viewing only and the operator can close the window.  
 

 
 

7 Software setting – the Tools menu 
 



The setting of functions and features are accessible via the Tools menu. Most items in this menu are only 
available to an operator with Supervisor rights.  

• Hex/Dec conversion table - displays a table for number conversion between the decimal 
system and the hexadecimal system.  

• Sound OFF - enables an operator with proper rights to suppress the generating of message sound 
effects. 

• Settings – the software administration 
o General parameters - enables an operator to perform some program setting up. 
o Format- enables format creation, editing, deleting or the import/export of communication 

formats.  
o Standard notes - enables predefined note creation, editing, and deleting.  

 
• Back up database as …-  creates actual backup of the main database.  

 

7.1 Hex/Dec conversion table 
The table is an useful tool in the course of codes conversion for the format communication checking. The 
window is always brought to front.  

(hex-hexadecimal system, dec-decimal system). 

 

Fig.17. The Hex/Dec converting table window 

Example of a conversion hexadecimal number B8 (HEX) to decimal number (DEC): 
To make a regular representation of the hexadecimal number find the according line to the first figure (B) 
in the table. Afterwards find the according column to the second letter (8) in the line. The converted 
decimal number is the intersection of the found line and column. So the result is 184.  

Example of a conversion decimal number 203 (DEC) to hexadecimal number (HEX): 
Find the decimal number 203 in the table. The first figure of the searched hexadecimal number is in the 
same line as the decimal number 203 lies, i.e. C. The second figure is in the same column, i.e. B. The 
searched hexadecimal number is CB. 
 



7.2 General parameters  
The Setting item is for changing the features and functions of the ComGuard software. The displayed 
window has five sheets:  

General 
 

 
 

Fig. 23 
• Connection string - the setting for the database connection, performing changes is not 

recommended.  

• External text editor - the operator can choose an editor for viewing Contracts. Contract viewing 
is possible on the General sheet of the Account window or in the Operator list window.  

• Time table tolerance - the set time represents a delay for generating special messages during the 
arming time. The special messages are generated in the case of a disarmed installation in the 
arming time 

• Font – the setting of the text font is valid only for the Messages and Important Messages. 

Messages 

• Message display and filter - the parameter determines how long history of received message is 
displayed in the message window. The numeric data in the gap is the number of days. 

• Display alarm window button – If the button is clicked, then every alarm message opens a 
special alarm window. There are two kinds of alarm window - the position of Suppress alarm 
message confirmation determines which kind of alarm window will be shown.  

• Suppress Alarm message window button - If the button is not clicked, an operator has to confirm 
message reception by pressing an extra button in the alarm window. If the button is clicked, more 
received messages appear in the Message window without operator confirmation in the case of the 
alarm window.  

• Suppress display of periodic test button - When the button is pressed down, the periodic test 
events are not displayed in the Messages window. The checking of the last received message from 
particular accounts is on in any case. 



 
 

Fig. 24 
 

Lost connection 
 

 
 

Fig. 25 
 

1) The "Suppress 24 hours extension" button is off:  
• The fix time interval for account supersvision is 24 hrs. A user can prolong this interval by setting 

of this parameter up to 24 hrs + set time. The maximum is 47 hrs and 59 minutes. E.g. if you set 
02:30 the warning message is released after 26 hrs and 30 minutes when the last event from the 
account was received. 

2) The "Suppress 24 hours extension" button is on:  
• The warning message will be released just after the set time interval, i.e. maximaly after 23 hrs 59 

minutes. 

•  Telephone line - the setting of supervision inteval for accounts communicating via telephone line 
formats. 
•  IP - the setting of supervision inteval for IP channel communication 



•  SMS - the setting of supervision inteval for SMS channel communication - backup path 
•  SMS Connect - the setting of supervision inteval for SMS Connect channel communication - backup 
path when installed 
•  With regard to the inner structure of the ComGuard software the warning message may be delayed of 
about three minutes compering with the set interval. The 3minute interval is the time of regular checking 
of account status .  
•  When the time edit box is set to 00:00, the function of the last message checking is off for the chosen 
channel.  

•  The supervision of the last message time interval can be set off for a particular account - see 
"Accounts" window" , sheet "Account status", press the Suppress button. 

Communication collector connection 
 

 
 

Fig. 26 
 

• The setting for the database connection where rough data event are stored. The data are stored just 
after receiving into the colector database without any translation, then they are proccesed by 
ComGuard.  

• Use communication collector button- turns on the reading of the collector database by the 
ComGuard. 

• Connection string - the setting for collector database connection, any change is not 
recommended.. 

Database backup 

• Use automatic backup button - button activates the automatic saving of the ComGuardMain 
database, which keeps all the data for Con¨mGuard software (Received messages, Account , 
Formats setting, etc). 

• Backup period field - the database back up period in days. 

• Backup daytime field - the setting of the daytime for database back up. 



• Path field - the setting of the path, where the backed up databse should be stored. Do not set the 
pathe, where any folder has space in its name, e.g. "folder 1"! The backed up file has the name 
"ComGuardMain_080905.bak", where the number means data of back up - DDMMYY. 

 
 

 
 
 

7.3 Formats 
 

 
 

Fig.17 The Formats window 
 
After software installation, several formats are preset: Ademco Contact ID, Ademco Express, Sur-Gard 
and the 4/2 format. These formats can be edited and copied. An operator may change the text of particular 
translation tables and other features of the report codes via this window. 
To edit text and the features of report codes in the translation tables, choose the format you want to edit 
and click the Edit text button. The window for editing is then displayed. 
The edit window differs in its appearance according to the chosen format: 



 
4/2 Format 
 
The left side of the window shows the list of report codes and their text translations. Theoretically, the 4/2 
format has 256 report codes (FF in hexadecimal), we must omit all the report codes which have “0” (zero) 
in it. The “0” is replaced by an “A” in a report code.  
The translation table of 4/2 format can be used for various types of formats, e.g.Ademco Slow, Ademco 
Fast, Franklin, Radionics, Sescoa.  
The important thing for appropriate translation is the structure of a format, no matter what the way of 
communication is (tone or DTMF format). 
The meaning of the functional elements: 
- Message text – the translation text of the chosen report code, 
- Message type – the setting of the message type (see the chap. 6.1), 
- Sound – each report code may be followed by a chosen sound. (only sound file format *.wav)  
 

 
 

Fig.18 The Text edit window 
 
- Confirm – saves the performed changes, 
- Original – does not save the performed changes and renews the original features of the report code, 
- Close – saves all the confirmed changes and closes the text edit window, 
- Cancel – closes the text edit window without saving any changes, 
- Export/Import – exports/imports translation tables from/to a *.csv or *cgp file. The *.csv file can be 

opened by a simple text editor outside ComGuard to make any editing changes. The “;”semicolon 
sign is not recommended to be used in the text, it is used as a seperator of particular information in an 
exported file. 

 
Ademco Contact ID format: 
The meaning of the Contact ID events editor functional elements: 
- Event code  - the code of the general part of a received message.  
- Event name – the translation text for the chosen report code. 
Source table – the setting of the direction for a type of source table – the definition of the source table 
according to the character of the received message; available sub-tables are Zone, User and Other 
information. The definition of the sub-tables should be followed in the translation table for event sources 
(CCC). 
 



 
 

Fig.19 The edit window for Contact ID text editing 
 
- Source editor (CCC) – opens a dialog window for event source editing.  
 

 
 

Fig.20 The dialog window for editing of event sources 
 

- Type of event – corresponds to the setting in the Contact ID events editor window – the character of 
the event source 

- Group number - the code of the event source (CCC), 
- Group name – the translation text of the source,  
- Sound – the setting is the same as the 4/2 format sound setting 
- Cancel, Confirm, Export/Import – the same function as the previous edit windows. 
 
SurGard format 
 
Control elements and their functions are similar to the edit windows of the previous formats. The SurGard 
format has a structure of 4/1/2, i.e. 4 digits for Account ID, 1 digit for the general part of the message 
(arming, disarming, etc.) and 2 last digits for the description of the event source. The Group menu is for 

shifting among the general part of message. The “three dots” button   opens a translation table for 
text editing the general part of message.     
 



 
 

Fig.21 The text edit window for the SurGuard format 
 

7.4 Standard  notes 
• Invokes a window for creating, editing, deleting particular items.  
• Predefined notes are added to messages by clicking on the Add notes item in the context menu. It 

is also possible on the Messages sheet of the Installation window by double clicking on a 
message.  

• The notes from this window are displayed in the Standard notes column of the Messages 
window and Filtered messages window.  

 
The window contains three buttons: 

• Add - adds the text in the edit field to the list below.  
• Delete - deletes a marked item from the list.  
• Save - replaces the text of the current item with the text in the edit field.  

 

 
 

Fig.22 The Predefined notes window 



 

8 Trouble shooting 
 

Problem Causes and solutions 

The program terminates after 
operator initiation with the 

error report:„abnormal 
program termination“ 

The program has already been started and is running in 
the background. Check programs running by pushing 
Ctrl+Alt+Del (Win 95 and 98) or open the task manager 
(Win NT a 2000). Then close the copy of Comguard 
running. 

Incoming message is 
translated as „Telephone line 

error or wrong format“ 

• the message contains unknown data 
• the account with the appropriate ID has a different 

format to that which the message contains 
• the account with this ID is being ignored 

The special alarm window is 
not followed by a sound  

• the volume of the wave output is turned down 
• the sound “Default beep” is not set in the Windows 

system. To set it, open the Control panel, then 
Sounds and multimedia. 

 

9 Information 
 
  
 

   
• For assistance please  contact us: 
Company:  Jablotron Ltd. 

Pod Skalkou 33 
466 01 Jablonec nad Nisou 
Czech Republic 

 
Phone: +420-483-559911, or +420-483-559931 
Fax:     +420-483-559933 
E-Mail: pco@jablotron.cz 

 

 


